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Before You Begin 
Before you begin, install and start DXtreme Station Log 15 by following the Installation 
Instructions we sent with your software.  

This document, the DXtreme Station Log 15 Getting Started Guide, explains how to get 
started with DXtreme Station Log 15 by showing you the most basic steps required to 
use it.  

There are many more features and functions available within the product, so please 
spend some time reading — and referring to — the DXtreme Station Log 15 Help 
system, which consists of two parts: Procedural Help and Field Help 

 Procedural Help 

If you don't know how to perform a task, click the Procedural Help button  and the 
first relevant Procedural Help topic for the window or dialog box you're on appears. If 
there's more than one relevant topic, you can click an adjacent topic on the help 
system's Contents tab to navigate to the help you need, but you'll be in the 
neighborhood. 

 

  



 

 2  

 Field Help 

For help with the fields of a window or dialog box you're on, click the Field Help 

button  and the relevant Field Help topic appears.  

 

Note: Both Procedural Help and Field Help are also accessible from menu bars and 
shortcut menus throughout the program. Refer to “Obtaining help” in the DXtreme 
Station Log 15 Help system for more information. 
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Setting Initial Preferences 

Identifying Your Home Entity 
When you start DXtreme Station Log 15 the first time, you see this message box: 

 

Click OK. The Station Log window appears.  

Resize it, if necessary, so it looks like the one shown.  

 

Then, on the Tools menu, click Preferences.  
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The Preferences window appears.  

 

In the Home Entity box, click the DXCC entity within which you live. Then click OK.   

Setting Other Preferences 
From time to time, you’ll revisit Preferences as you work with DXtreme Station Log 15.  

Let’s set some basic preferences right now. On the Tools menu, click Preferences. 
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User 
Click the User tab. 

 

Type your name, call, and location information. If you experience trouble accessing 
Internet features within Station Log 15, enter your profile for Internet Access (consisting 
of your logon credentials established with your ISP). In the Distance Unit field, select the 
desired unit of measure for distance calculations made by Station Log 15. 

Note: The Link to UDF check box and its adjacent list box allow you to assign 
coordinates and grid squares to multiple operating locations, which you may want to 
configure in a user-defined field (described in the next section).  Bearing and distance 
calculations will be made, and plots* and reports will be based on the coordinates of the 
operating location selected for each log entry on the User Defined Fields tab of the 
Station Log window. Bearing calculations and plots on the DX Spot Checker will be 
based on the coordinates of the default operating location.  
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If you do not want to set up operating locations in a user-defined field, all bearing and 
distance calculations, plots*, and reports are based on the default latitude and 
longitude specified on the User tab. Refer to “Entering your name and location and 
specifying UDF link definitions” in the Procedural Help for more information. 

* — a license for Afreet DX Atlas is required to perform plots. Click http://www.dxatlas.com for more information. 

Database + UDF 
Click the Database + UDF tab. 

 

Logging Mode 

________________________________________________________________________ 
Important: If Region in Window’s Control Panel is not set to the United States, check to 
see whether Region is configured to use the comma as the decimal symbol. If the 
comma is the decimal symbol for your region, select Comma As Decimal Symbol on the 
Database + UDF tab in Preferences and make sure your latitude and longitude fields on 
the User tab have commas instead of periods. In addition, make sure you have set your 
Time fields correctly in Region, as described in the DXtreme Station Log 15 Installation 
Instructions. 

If Region is set to the United States, the Comma As Decimal Symbol check box on the 
Database + UDF tab in Preferences should have no check mark next to it. And there is 
no need to change your Time fields in Region. 

  

http://www.dxatlas.com/
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User-Defined Fields 

Manage your User-Defined Fields as desired.  

In addition to others, we defined Contest Name and Contest Serial Number text box 
fields so we can use the Contest Duplicate QSO Checking facility (described later). In 
addition, we defined an Operating Location list box field to accommodate the locations 
from which we operate. These user-defined fields will appear on the User Defined 
Fields tab of the Station Log window, the Set Criteria window for reports, and the ADIF 
Import Utility and LoTW QSL Update Utility for data imports and updates. 

As part of the Operating Location definition, we clicked the adjacent Define List button 
and listed our operating locations, specifying Sugar Hill as the default Station Log will 
select automatically when we add a log entry. We can change the location, of course, on 
the User Defined Fields tab of the Station Log window and its utilities.  
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Note: At this point, if desired, we could use the Link to UDF check box and its adjacent 
list box on the User tab to assign coordinates and grid squares to the operating locations 
just defined.  

 

Bearing and distance calculations would then be made, and plots* and reports would 
then be based on the coordinates of the Operating Location selected for each log entry 
on the User Defined Fields tab of the Station Log window. Bearing calculations and 
plots on the DX Spot Checker would continue to be based on the coordinates of the 
default operating location. If you want to use this feature, refer to “Entering your name 
and location and specifying UDF link definitions” in the Help system for more 
information and instructions. 

* — a license for Afreet DX Atlas is required to perform plots. Click http://www.dxatlas.com for more information. 

Keep Last 

If you’re not using rig-control, you can click Keep Last … 
 

 

http://www.dxatlas.com/
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… to add the Keep? check box to the Station Log window. 
 

 

When you select Keep?, Station Log 15 retains the frequency and mode between log 
entries until you clear the check box or click Cancel.  

VFO Tuning 

If you clicked Omni-Rig or HRD 5, click the VFO Tuning option that works best with your 
radio: VFO A and B or VFO Generic. Some experimentation is necessary. 

 

VFO A and B 

When you select VFO A and B, the VFO A and VFO B option buttons are enabled on the 
Tune tab of the Station Log window, and the Tune VFO-A to Frequency and Tune VFO-B 
to Frequency menu items appear on the shortcut menu of the DX Spot Checker.  

On some radios, tuning occurs on the VFO corresponding to the VFO A or VFO B option 
button clicked on the Tune tab of the Station Log window, or the Tune VFO-A to 
Frequency or Tune VFO-B to Frequency menu item clicked in the DX Spot Checker.  

On other radios, tuning occurs only when clicking the VFO A option button on the Tune 
tab of the Station Log window, and the Tune VFO-A to Frequency item in the DX Spot 
Checker. In this instance, tuning occurs on the VFO currently selected on your radio. We 
have no control over this behavior. 

VFO Generic  

When you select VFO Generic, the VFO A option button is the only one enabled on the 
Tune tab of the Station Log window, and the Tune Rig to Frequency item is the only one 
appearing on the shortcut menu of the DX Spot Checker. Tuning occurs on the VFO 
currently selected on your radio (A or B).   
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General 
Click the General tab. 

 

If you subscribe to Buckmaster™ HamCall.net™, QRZ XML Logbook Data, and/or 
HamQTH.com, click the appropriate option button and enter the user name and 
password for that call sign subscription service. If you want to enter the user name and 
password of another service, click Apply after each user name and password 
assignment. If you subscribe to Buckmaster™ HamCall CD, click its option button and 
browse to where the HamCall database resides on your PC.  

Station Log 15 works best with QRZ XML Logbook Data and HamQTH.com.  

A toolbar button on the Station Log window makes it easy to switch between services. 
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Note: If you are using the HamCall CD, be sure to install the HAMCAL32.DLL file in your 
Windows/System32 folder on 32-bit systems or the Windows/SysWOW64 folder on 64-bit 
systems. The HAMCAL32.DLL file resides in the \HamCall\API\Windows folder on the 
HamCall CD. 

Click Show Retain Date Check Box if you plan, as part of your implementation, to type-
in contacts from years past on the Station Log window. Doing so allows you to freeze 
the date across multiple entries. You might also find our DXtreme Interchange product 
helpful for populating your Station Log database with log entries from non-ADIF 
sources. Refer to https://www.dxtreme.com/prods_dxinterchange.htm for more 
information. 

If your location observes Daylight Saving Time, select Automatic ST DST UTC so Station 
Log 15 obtains Standard Time/Daylight Saving Time information from Windows Time 
Zone Settings and adjusts the UTC date and time within Station Log 15 automatically 
when your site changes from Standard Time to Daylight Saving Time and back again. For 
locations that don't observe Daylight Saving Time, clear Automatic ST DST UTC and set 
the UTC Bias value manually. 

Note: If you have upgraded from an earlier version of Station Log you will need to reset 
your UTC Processing settings.   

https://www.dxtreme.com/prods_dxinterchange.htm
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Internet 
Click the Internet tab. 

 

In the File Specification of Web Browser for General Use area, use the Browse button 
to navigate to and select the file name of the browser you want to use for non-Report-
Viewer use. If Microsoft Edge is your registered default browser in Windows 11 and 
Windows 10, type Edge to use it. 

Important: The file specification of the browser we entered may not be appropriate for 
your system. Use the browse button to select the browser on your system. 

In the E-Mail Client/Recipients for DX Spot Announcements and Images Sent By E-Mail 
area, select the e-mail client you want to use. If you select Mozilla Thunderbird, use the 
Thunderbird box to specify the fully qualified path to where your copy of Mozilla 
Thunderbird resides. If necessary, click the Browse button to find the path. If Mozilla 
Thunderbird is not installed, this box contains the path to the Audio subfolder of 
DXtreme Station Log 15. Use the Recipients box to enter the e-mail addresses of people 
you want to send DX spot announcements and images to. 

In the Club Log Upload Management area, make sure the URL box contains the address 
of the Club Log Web site. Select the Create and Append Club Log Records Automatically 
When Log Entries Are Added/Modified check box to create Club Log workfile records 
automatically whenever you add or modify log entries. 
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Solar 
Click the Solar tab. 

 

Unless you want to prevent the automatic acquisition of solar indices from NOAA, you 
should verify that the Enable Automatic Acquisition of Today’s Solar Indices From 
NOAA check box is selected.  
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Outgoing QSLs 
Click the Outgoing QSLs tab. 

  
 
In the QSL Label Properties area, if Always Create Multi-line QSL Labels is selected, 
specify the desired Closing Expression and Signature text you want to display on QSO 
labels. If you want to display the Shortcut frequency in MHz (as defined on the Bands 
module window) instead of the band on QSL labels, select the Shortcut MHz Instead of 
Band on Direct Print Labels check box; otherwise, the band appears.  
 
In the eQSL.cc Properties area, select the Create and Append eQSL.cc Records 
Automatically When Log Entries Are Added/Modified check box to create eQSL.cc 
workfile records automatically whenever you add or modify log entries. 

In the Outgoing QSL Web Service Properties area, specify the outgoing QSL web service 
you want to use. Station Log’s Outgoing QSL Web Service facility makes it easy to add 
and manage the workfile records you’ll eventually upload to the Outgoing QSL Web 
Service you chose for distribution. At the time of this writing, DXtreme Software 
recommends QDure at https://qsl.ure.es/en/.  

Refer to Outgoing QSL Web Service Integration in this document for more information. 

 

https://qsl.ure.es/en/
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Auto Backups 
Click the Auto Backups tab. 

 

Select the appropriate check boxes and then browse to the locations where you want 
your important Station Log 15 files backed up.  

Database, Audio, Improv Imaging, and QSL Imaging backups occur automatically when 
you close the program. Database backups also occur when you switch databases on the 
Database + UDF tab. 

Cloud services like OneDrive and USB flash drives are ideal destinations for such 
backups. Make sure they’re connected/mounted on your system before the  
backups run. 
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Report Viewer 
Click the Report Viewer tab. 

 

In the Report Viewer Preferences area, select the desired viewer for Performance, 
Bands, and Stations reports by clicking the appropriate option button. 

The Active Report Viewer lets you view, share, and sort reports within Microsoft 
Internet Explorer and Microsoft® Edge™ in Internet Explorer Mode.  

The Standard Report Viewer lets you view and share reports within Apple® Safari®, 
Google™ Chrome™, Mozilla® Firefox®, Microsoft Edge, Vivaldi™, and some other 
browsers. 

In the Active Report Viewer File Specification … box, specify the file specification of 
Microsoft Internet Explorer or Microsoft Edge. If using Edge, you’ll need to follow the 
instructions in the DXtreme Station Log/Internet Explorer Mode Information Center to 
display the Active Report Viewer in Internet Explorer Mode. Click the following link 

to access this Information Center at: 
https://www.dxtreme.com/dxsl_iemode_ic/informationcenter.htm. 

In the Standard Report Viewer File Specification … box, specify the file specification of 
the desired browser. 

Important: The file specifications of the browsers we entered may not be appropriate 
for your system. Use the browse buttons to select the file specifications of the browsers 

https://www.dxtreme.com/dxsl_iemode_ic/informationcenter.htm


 

 17  

on your system. To display Standard Reports in Edge, Google Chrome, Vivaldi, and other 
browsers locally, you must also append the --allow-file-access-from-files switch 
to the browser executable (include a space character between the file spec and the 
switch). In addition, make sure no other instance of the browser is running on your PC 
when you display reports locally. 

LoTW 
Click the LoTW tab. 

 

In the TQSL and LoTW Account Properties area: 

▪ Verify where the TQSL application resides on your PC. The file specification we 
entered may not be appropriate for your system. TQSL V2.4 or greater is 

required if you want to upload log entries to Logbook of the World. 

▪ Type your TQSL Password. 

▪ Type your Active Station Location. If you have more than one station location, 
you must change it here to the current one. The Automatic LoTW Upload 
Progress caption on the Station Log window displays your active station location 
in parentheses and provides right-click access to the LoTW tab of Preferences.  
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In the Automatic LoTW Upload Properties area: 

▪ Select whether to Upload Individual Log Entries Automatically. 

▪ If necessary, set the Processing Interval low enough so automatic uploads occur 
quickly, but high enough so LoTW QSO Record Status is retrieved from the LoTW 
Server. 

In the Batch LoTW Upload Properties area: 

▪ When performing batch LoTW uploads, select Upload Log Entries 
Semiautomatically if you want TQSL to upload log entries to the LoTW Server for 
you and return LoTW QSO Record Status for the batch. Clear this check box to 
upload signed.tq8 files yourself on the LoTW Web page or by e-mail (Manual 
mode). 

▪ Set the Processing Interval low enough so semiautomatic uploads occur quickly, 
but high enough so LoTW QSO Record Status is retrieved from the LoTW Server. 

▪ Set whether to Display the LoTW Web Page When Uploading. 

▪ Specify the URL of the LoTW web site. 

▪ Set a desired TQSL Display Delay so TQSL appears on top of the LoTW web site in 
Manual mode only, useful if you want to watch TQSL in action.  

In the Progress Caption Properties area:  

▪ Set the desired foreground and background colors of progress captions 
application-wide. 

▪ Select whether to apply Bold and/or Italics attributes to captions. 

In the Progress Bar Properties area: 

▪ Set the desired foreground and background colors of progress bars application-
wide. 

▪ Select whether to apply a 3D Effect, a Border, and/or a Solid versus segmented 
appearance to the bar. 

Note: DXtreme Software suggests you perform limited LoTW uploads until you gain 
experience with them. 
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DX Atlas 
If you own a license for Afreet DX Atlas, click the DX Atlas tab. 

 

Select the Invoke check box and spend some time experimenting with the various 
settings. Refer to our Help system and to the Afreet DX Atlas documentation for more 
details. 

Read “Guidelines when viewing DX Atlas maps” in the Tips and Tricks → For Using 
Station Log section of our Help system. 
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Contests 
Click the Contests tab. 

 

If you’re a casual contester, you can use this tab to set Station Log 15 so it flags 
duplicate contacts (dupes) per band and mode when you attempt to log them, giving 
you the option of whether to continue.  

Dupe checking begins at the date and time you specify and continues until you turn 
contest processing off. If desired, you can specify the name of the contest and link it to 
one of your text-based user-defined fields (UDFs) so it’s saved with each log entry. At 
your option, you can also request the generation of incremental serial numbers, linking 
the numbers to another of your text-based UDFs for saving with each log entry. A 
provision to reset the serial number is provided. 

There is no output to Cabrillo due to the sheer number of QSO templates involved. 
Serious contesters should use a contest logging program, and then import their logs into 
DXtreme Station Log 15. 
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Band Master 
If you own a license for Afreet Band Master, click the Band Master tab. 

 

Select the Invoke check box. 

In the Entity List Location area, click Browse to select the file specification of the Band 
Master Entity Needed List file.  

In Windows 11, Windows 10, Windows 8.1, Windows 8, Windows 7, and  
Windows Vista 

The Entity Needed List file is typically at: 

C:\Users\{username}\AppData\Roaming\Afreet\UserData\WkdAdif.lst 

In Windows XP 

The Entity Needed List file is typically at: 

C:\Documents and Settings\{username}\Application 

Data\Afreet\UserData\WkdAdif.lst 
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In the IOTA List Location area, click Browse to select the file specification of the Band 
Master IOTA™ Needed List file.  

In Windows 11, Windows 10, Windows 8.1, Windows 8, Windows 7, and  
Windows Vista 

The IOTA Needed List file is typically at: 

C:\Users\{username}\AppData\Roaming\Afreet\UserData\WkdIota.lst 

In Windows XP 

The IOTA Needed List file is typically at: 

C:\Documents and Settings\{username}\Application 

Data\Afreet\UserData\WkdIota.lst 

In the Display Delay list box, click the desired delay setting so Band Master appears 
after Station Log 15 has had a chance to build the Entity and IOTA Needed Lists you 
request on the Tools menu of the Station Log window. The higher the number, the 
longer the delay, and you should increase the number if you notice Band Master 
indicating you need entities and islands you do not. You can view the needed lists in 
Band Master via its Tools menu.  

For more information, refer to Checking DX Spots → Using Band Master in our Help 
system. 
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Ham CAP 
If you’ve downloaded and installed Afreet Ham CAP, click the Ham CAP tab. 

 

Select the Enabled check box and set properties as desired: 

▪ Initial Display Tab — Initial display of Chart or Map. 

▪ Average Power — Average power you're running. 

▪ IonoProbe On — If you have the optional Afreet IonoProbe* application installed 
on your PC and want it to automatically provide solar information to Ham CAP, 
including the 90-day smoothed sunspot number (SSN). When this option is 
enabled, IonoProbe overrides the K-Index value supplied by Station Log 15. 
When IonoProbe is not installed, or is disabled, you may want to adjust the 90-
day smoothed sunspot number manually on the Params tab of Ham CAP.  
Note: Afreet Software has discontinued IonoProbe. Some of its features are no 
longer supported. Refer to http://dxatlas.com/ionoprobe/ for more information. 

▪ Use Kp — Whether you want Ham CAP to include the current K-Index value in its 
prediction calculations. If you don't have IonoProbe installed or enabled, the K-
Index value is supplied by Station Log 15 (if your Internet connection is active 
and the index is available from NOAA). 

▪ Map Style — Color, Gray, or Pseudo to suit your taste. 

▪ Map Resolution — High, Medium, or Low to suit your taste. 

http://dxatlas.com/ionoprobe/
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▪ Default Band — Band to select when the frequency of the spot is outside the  
80-, 40-, 30-, 20-, 17-, 15-, 12-, or 10-Meter band, or when you invoke Ham CAP 
from the action bar. You can, of course, change the band on the Ham CAP 
interface. 

▪ Show Sun — Whether to show sun position on the Map display. 

▪ Plot Path — Whether to plot the path on the Map display. 

▪ Plot MUF — Whether to plot the maximum usable frequency on the Chart 
display. 

Note: To use Ham CAP effectively, users must configure other parameters and settings 
on the Ham CAP interface. Home and DX coordinates are supplied by Station Log 15. 
Further, we encourage users to read the Ham CAP on-line documentation, which is 
available on the Ham CAP web page. 

* — a license for Afreet IonoProbe is required to use it. Click http://www.dxatlas.com for more information. 

  

http://www.dxatlas.com/
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JT log Entry Processing 
If you’re a fan of WSJT-X, JTDX, or JS8Call and you want to use JT Log Entry Processing, 
click the JT Log Entry Processing tab. 

 

Click the desired  button to set the location of:  

▪ WSJT-X's wsjtx_log.adi file.  

▪ On 64-bit systems, this file is typically located at: 
c:\Users\[your_user_name]\AppData\Local\WSJT-X  

▪ On 32-bit systems, this file is typically located at: 
c:\Documents and Settings\[your_user_name]\Local 

Settings\Application Data\WSJT-X  

• JTDX's wsjtx_log.adi file.  

▪ On 64-bit systems, this file is typically located at: 
c:\Users\[your_user_name]\AppData\Local\JTDX  

▪ On 32-bit systems, this file is typically located at: 
c:\Documents and Settings\[your_user_name]\Local 

Settings\Application Data\JTDX  
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• JT8Call's js8call_log.adi file.  

▪ On 64-bit systems, this file is typically located at: 
c:\Users\[your_user_name]\AppData\Local\JS8Call  

▪ On 32-bit systems, this file is typically located at: 
c:\Documents and Settings\[your_user_name]\Local 

Settings\Application Data\JS8Call  

In the Submodes to Log As Modes box, specify the submodes you want Station Log to 
log as modes. If typing multiple submodes, separate each with a semicolon.  

For example: FT4 is a submode of MFSK and appears in the wsjtx_log.adi file as 
<mode:4>MFSK <submode:3>FT4. Including FT4 in the Submodes to Log As 

Modes box ensures FT4 will be logged as a mode in Station Log. FT4 must be listed in 
the Modes module; you'll be prompted to add it one time if it is not. 

In the Write Submodes To list box, specify the text box on the Station Log window 
where the submode of each qualifying JT log entry will appear, for informational 
purposes, whether it was logged as a mode. You can choose:  

▪ None  

▪ Comments Box 1  

▪ Comments Box 2  

▪ UDF Text Box 1  

▪ UDF Text Box 2  

▪ UDF Text Box 3  

▪ UDF Text Box 4  

▪ UDF Text Box 5  

▪ UDF Text Box 6  

▪ UDF Text Box 7  

▪ UDF Text Box 8  

Worked-Before Management 

The WSJT-X and JTDX worked-before features have the benefit of displaying worked-
before status indications natively, letting you keep your eyes glued to the WSJT-X or 
JTDX interface while operating — which we consider important, especially when using 
quick modes like FT8 and FT4. 

As such, our approach to JT Log Entry Processing is unique; whereby DXtreme Station 
Log 15 manages the prepopulation of WSJT-X and JTDX log files and the addition of 
comprehensive log entries, while WSJT-X and JTDX display worked-before status 
indications as you operate. No other software is required. 



 

 27  

Because JS8Call specializes in real-time conversational keyboard-to-keyboard QSOs, 
store-and-forward messaging, plus automatic and manual station queries and replies, 
the concept of worked-before status (whereby operators are discouraged from making 
more than one contact per band and mode) does not apply. Therefore, prepopulation of 
its log file is neither required nor provided. 

Refer to the Procedural Help system for more information. 
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Setting Initial DX Spot Checker Options 
On the Tools menu of the Station Log window, click DX Spot Checker.  

Then, on the Tools menu of the DX Spot Checker, click Options. 

Server and Spots 
Click the Server and Spots tab. 

 

Type the network addresses and port numbers of each Site you want to access.  
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For your convenience, a link to an on-line DX Packet Cluster telnet list is present (by 
default) in the Links menu. 

 

Important: Using servers that display rapid-fire, Skimmer-type spots can overwhelm the 
DX Spot Checker. Use them at your own risk. 

When you’re finished defining sites, click the Site option button of the preferred server, 
the server to connect to when you click the traffic light on the DX Spot Checker toolbar. 

As an alternative, the traffic light on the DX Spot Checker toolbar has a menu that lets 
you switch sites without opening the DX Spot Checker Options window. 

 

Note: Keep in mind, however, that you cannot switch back-and-forth quickly between 
sites. Each site requires a few minutes to process disconnections. 
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Additional Commands 
Click the Additional Commands tab. 
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Define the commands you want to invoke when you: 

▪ Click the corresponding command buttons on the right side of the Rich Site Feed 
on the DX Spot Checker window. 
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▪ Or click the corresponding menu items on the DX Spot Checker toolbar. 
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▪ Or press the corresponding function key combinations on your keyboard. 

 

If the Send check box is selected for a command in DX Spot Checker Options, the DX 
Spot Checker sends the command to the server immediately. 

Otherwise, a template of the command appears in the Send Command box on the DX 
Spot Checker window for editing. Overwrite the <placeholder> with desired information 
and press Enter on your keyboard to send the command. 
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You can also right-click a button on the DX Spot Checker window and click Define …  

 

… to access and perhaps change its definition on the Additional Commands tab in DX 
Spot Checker Options: 

 

For your convenience, links to on-line documentation for AR-Cluster, CC Cluster, and 
DXSpider servers are present (by default) in the Links menu. 
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Services 
In addition to the server-side filters provided by the operators of DX Cluster and DX 
Spider servers, DX Spot Checker Services let you filter your spots on the client side so 
you see only the spots you’re interested in. Using such filters and services can prevent 
the DX Spot Checker from becoming swamped with spots, especially during contests. 

Click the Services tab and then the Help buttons to explore and implement the services 
that interest you most. 
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Mode-Per-Band Plans 
If you select Suppress DXCC Announcements by Mode Per Band in the Spot Display 
Filtering area of the Services tab, click the Modes-Per-Band Plans tab. 

  

Define or refine your Modes-Per-Band Plans. 

After you define your band plans with Suppress DXCC Announcements by Mode Per 
Band activated, you'll see only the spots you need for mode-entities not worked and 
not verified within each defined band-portion with the understanding that you cannot 
overlap mode definitions across band-portions (in another words, you can define only 
one mode per band-portion). Refer to the DXtreme Station Log 15 Help system for 
specific instructions. 
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Two Modes-Per-Band-Plan Files 

Two predefined Modes-Per-Band Plans files come with DXtreme Station Log 15: 

▪ One that contains CW and SSB mode definitions: 
DXSpotBandModeEntitySuppressionDefinitions.xml  

▪ And another that contains a mixture of modes, as shown above: 
DXSpotBandModeEntitySuppressionDefinitionsMixture.xml 

The CW and SSB version is selected by default. If you want to use the Mixture version: 

1. With DXtreme Station Log 15 closed, open File Explorer and navigate to 
c:\DXtremeStationLog15. 

2. Rename: 

DXSpotBandModeEntitySuppressionDefinitions.xml 

to  

DXSpotBandModeEntitySuppressionDefinitionsCwSsb.xml  

3. And then rename:  

DXSpotBandModeEntitySuppressionDefinitionsMixture.xml 

to  

DXSpotBandModeEntitySuppressionDefinitions.xml  

4. Start DXtreme Station Log 15. If necessary, refine your Modes-Per-Band Plans. 
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Populating the Modules 
When you populate modules, you’re ensuring that data regarding DXCC entities, bands, 
prefixes, rigs, antennas, accessories, and so on are uniform throughout your Station 
Log 15 installation. This activity is essential for maintaining the integrity of your data, 
especially when running reports.  

Access the following modules from the Modules menu of the Station Log window and 
perform the required tasks. 

Entities Module 
Make sure the Entities module is up-to-date with the latest DXCC® entities. When the 
ARRL makes changes to the DXCC Entities list, DXtreme Software posts an 
announcement at https://www.dxtreme.com/dxccinfo.htm.  

 

Important: Typically, you add new entities and change entity information when needed 
within the Entity Data area only. The system populates the Mode Data and Band Data 
areas automatically as you add and modify log entries. The only exceptions are if you 
decide, during implementation, to enter existing DXCC and Band information manually 
and begin logging thereafter (as explained in the DXtreme Station Log 15 Installation 
Instructions) and to specify favorite QSL Image files. 

https://www.dxtreme.com/dxccinfo.htm
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Caution: You must add to Entities any deleted DXCC entities you have worked in the 
past before importing ADIF files of old logging data or typing them manually. If you 
make prefix changes or add new entities, the next time you perform a Prefix and Call 
Sign Cross-Reference Update be sure to Clear Exception Cache and perform an 
Interactive Update. Refer to Prefix and Call Sign Cross-References for instructions. 

Rigs, Antennas, Accessories, Power Modules 
Access the following modules in the order presented and add the desired information. 
Then select the Default you want to appear when adding log entries. You can delete 
information that is not applicable after you have set defaults by band in the Bands 
module (described next).  

▪ Rigs — Add your radios. 

▪ Antennas — Add your antennas. 

▪ Accessories — Add your accessories. 

▪ Power — Add the power levels you run. 
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Note: When a window shows an unneeded column (like the one labeled N/A), you can 
change column widths to hide the column for aesthetic purposes and to provide more 
room for data. The software saves column width changes when you close the window. 
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Bands Module 
Make sure the Bands module contains the bands on which you operate. And, for each 
band, the desired rig, antenna, accessory, and power defaults. When you import, or add 
log entries for a band, DXtreme Station Log 15 selects the rig, antenna, accessory, and 
power level automatically. You can change them, of course. 

  

Important: Typically, you add new bands and set defaults within the Band Data area 
only. The system populates the Mode Data area automatically as you add and modify 
log entries. The only exceptions are if you decide, during implementation, to enter 
existing DXCC and Band information manually and then begin logging thereafter (as 
explained in the DXtreme Station Log 15 Installation Instructions) and to specify favorite 
QSL Image files. 

After you have made your default rig, antenna, accessory, and power entries, you can, if 
desired, revisit the appropriate modules and delete the rigs, antennas, accessories, and 
power levels you don’t want listed. Station Log 15 will not let you, however, delete a rig, 
antenna, accessory, or power level being used elsewhere in the system. You can set 
such records to Inactive so they don’t appear in list boxes throughout the system. 

The Shortcut box lets you type the shortcut MHz number for each amateur band when 
adding, modifying, or finding records in your Bands table. If desired, you can type the 
shortcut designation in the Freq box on the Station Log window in lieu of a complete 
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frequency, and you can print the shortcut designation instead of the band on Direct 
Print QSL Labels by selecting the Shortcut MHz Instead of Band on Direct Print Labels 
check box on the Outgoing QSLs tab of Preferences. 

Modes Module 
Access the Modes module. Add or modify the desired information. Select the Default 
mode (in the Status field) you want to appear when adding log entries. Delete 
information that is not applicable.  

 

If desired, assign signal report defaults to your modes. When you do, the Sent and Rcvd 
boxes on the Station Log window display a mode-specific default when the mode is 
selected while adding a log entry. 

When only one report character is assigned to a mode, the cursor appears at the end of 
that character when tabbing to the Sent and Rcvd boxes on the Station Log window: 
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This action permits the quick appending of additional characters, as is probably the 
intent, and comes in handy for digital modes (like FT4) when a hyphen (-) is assigned as 
the report default and you simply want to type the db number, as shown here: 

 

When more than one report character is assigned to a mode, the cursor selects the 
entire report for possible replacement: 

 

Here the default report was replaced with 579 in the Sent box and retained in the Rcvd 
box: 

 

You can change the default mode entered on the Station Log window when adding or 
modifying log entries, of course. 
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IOTA Module 
Important: You must perform an IOTA™ update before you can use IOTA numbers in 
DXtreme Station Log 15. 

 

While DXtreme Software does not have permission to distribute the Islands On The Air 
directory, when this topic was written the IOTA web site at https://www.iota-world.org 
had a PDF file you can download and reformat for update. Refer to IOTA Reference 
Numbers and Descriptions in this document for instructions. 

Like other modules, you can add, modify, and delete IOTA reference numbers and 
descriptions on the IOTA Module window.  

 

  

https://www.iota-world.org/
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STOP! .... Backup Time! 
If you configured Auto Backups in Preferences …  

 

… close Station Log 15 via File → Exit to back up your database file to the folders 
specified before using the software further.  

That way, if you make a mistake implementing DXtreme Station Log 15 and want to 
start over, you can close Station Log 15 via File → Exit Without Backing Up Database or 
File → Exit Without Compacting Database and Backing Up Anything and restore your 
backed-up database by copying the dxslme.mdb file from one of your backup locations 
to your current database location (usually c:\DXtremeStationLog15\Database). This 
action saves you from having to populate your module data all over again. 
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Adding Legacy Contacts 
Adding existing log data is the most challenging part of using a new logging application. 
And there are four ways to add existing log data to DXtreme Station Log 15. You can:  

▪ Enter existing DXCC and Band information manually into the Entities and Bands 
modules and begin logging thereafter, as explained in the DXtreme Station  
Log 15 Installation Instructions. 

▪ Type-in your existing contacts. If you choose this method, be sure to select Show 
Retain Date Checkbox on the General tab in Preferences. When you do, a Retain 
check box appears under the Date field on the Station Log window, which 
enables you to persist a date over multiple log entries. 

Note: Optional DXtreme Interchange can digitize your paper logbooks (or other 
non-ADIF sources) as quickly as possible using a combination of essential data 
entry; dictation, type, and paste; and active-importation. Read the DXtreme 
Interchange Data Sheet for more information. 

▪ Import your existing contacts from ADIF files, as explained in the next section. 

▪ Download and import contacts from the Logbook of the World (LoTW) Server if 
you’re a user of LoTW. Refer to the Information Center for instructions.  

  

https://www.dxtreme.com/dxinterchangedata.htm
https://www.dxtreme.com/dxinterchangedata.htm
https://www.dxtreme.com/dxsl15_ic/informationcenter.htm#maint
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Importing ADIF Files 
The easiest approach is to use the ADIF Import Utility to import legacy log entries from 
a valid ADIF file, one that has been generated by your old logging program. 

 

How the ADIF Import Utility Selects Entities for Log Entries Being 
Imported 
DXtreme Software recommends that QRZ XML Logbook Data or HamQTH.com be 
obtained and activated while using the ADIF Import Utility because those call sign 
subscription services return the DXCC Entity Code for each station most often, thereby 
increasing the accuracy of entity selection and entity-needed status indications. 

Here's how the utility finds the entity of each imported station: 

1. When a DXCC Entity Code is present in the ADIF file for the station, the utility uses it 
to obtain the entity from the Entities module.  

2. When a DXCC Entity Code is not present in the ADIF file for the station, the utility 
polls QRZ XML Logbook Data or HamQTH.com (if obtained by you and activated) for 
the entity code. If a code is returned, the utility uses it to obtain the entity from the 
Entities module.  

3. If neither QRZ XML Logbook Data nor HamQTH.com are activated, or they fail to 
supply the needed entity code, the utility uses the standard prefix (if present) of the 
call sign to obtain the entity from the Entities module.  

4. If the call sign has a non-standard (special) prefix, the utility uses the Prefix and Call 
Sign Cross-Reference modules to obtain the entity.  
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Note: DXtreme Software is not responsible for the accuracy of information supplied by a 
call sign subscription service or the Country.Dat file, which is used to update the Prefix 
and Call Sign Cross-Reference modules.  

What to Do Before Importing a Previous Log 
You must add to the Entities module any deleted DXCC entities you have worked in the 
past before importing ADIF files of old logging data. You must also ensure the Bands 
module lists all bands you’ve operated on, and you must select the desired defaults as 
explained in this message box, which you’ll encounter when you start the ADIF Import 
Utility: 

 

If you’ve already set your defaults as explained in the ADIF Import Processing message 
box, you can click Yes to begin. If not, click No, set your defaults as explained, and 
restart the ADIF Import Utility.  
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Important — Be Sure to Do This! 
After you click Yes on the ADIF Import Processing message box, you’ll be prompted to 
create a pre-import database backup file. Make sure you select a writable backup folder 
into which the pre-import database backup file will be placed prior to import. Desktop is 
okay. 

 

Keep in mind, however, if you select the same folder each time you import, the previous 
file will be overwritten (which may or may not be okay). If you want to retain prior 
backup files, select a different writable backup folder each time you import. It’s up to 
you. 

This pre-import database backup file is in addition to the standard backup file saved 
when closing Station Log 15 if you configured Automatic Backups in Preferences. 

If a problem occurs with the import — which happens sometimes — you can close 
Station Log 15 via File → Exit Without Backing Up Database or File → Exit Without 
Compacting Database and Backing Up Anything and restore by copying the pre-import 
database backup file or standard backup file (dxslme.mdb) file from the desired backup 
location to your current database location (c:\DXtremeStationLog15\Database) 
usually. 

Correct the problem and then try again. This action protects your module data and 
previous log entries if something goes wrong during an import. And if you need our help 
with an import, sending us your backed-up database helps us help you. 
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How the Import Behaves 
The import process is interactive. The interactive nature of the import process ensures 
the imported data will be compatible with the Station Log 15 database schema. The 
import process cannot be interrupted and resumed. However, if your source ADIF file is 
separated into manageable, ADIF-compliant chunks — say one file for each year of 
operation — the import process can be more gradual and manageable. 

If your ADIF file does not have DXCC tag numbers (which identify the DXCC entity of 
each imported log entry), you can select in the Validation Options area whether to 
Approve the entity selections the utility makes based on the standard and special 
prefixes in the system. Important: Employing this option will be very time-consuming! 
But if you clear the Approve check boxes, the utility makes logical entity selections 
without prompting you unless necessary. (Prompting for States and Provinces and CQ 
Zones can also be time-consuming.) 

Important: Most users don’t select the Approve and Prompt check boxes when 
importing an existing log. The accuracy of entity selections then depends on whether 
you’re using QRZ XML Logbook Data or HamQTH.com and how well you’ve kept your 
Entities, Prefix Cross-Reference, and Call Sign Cross-Reference modules up-to-date. 
Refer to the Entities Module section for more information about keeping the Entities 
module up-to-date, and to the Prefix and Call Sign Cross-References section for more 
information about keeping those modules up-to-date. 

As it imports each log entry, the ADIF Import Utility assigns the defaults specified in the 
maintenance modules of the system, including the rig, antenna, accessory, and power 
level per band. In addition, it applies the signal and propagation, solar, digital 
application, UDF, and QSL defaults you specified on the utility’s window when those 
values are not present in the ADIF being imported.  
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The ADIF Import Utility has its own Help system. Refer to it when using the utility. 
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Checking DX Spots 
On the Tools menu, click DX Spot Checker. 

Logging On 

Service Set Identifier 
If you want to log on to the same cluster server on multiple devices at your site, select a 
unique Service Set Identifier (SSID) on each device prior to logging on. The SSID box is 
labeled with your call sign and a trailing hyphen, selecting a unique SSID prevents being 
forcibly logged off. 

 

Ready … Set … Go 
Click the traffic light to log on to the server selected in DX Spot Checker Options. As an 
alternative, click the down arrow next to the traffic light and then the server you want 
from the menu.  

 

Note: You cannot switch back-and-forth quickly between sites. 
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Selecting the Feed 
Choose the Feed option you want. Feel free to switch back and forth. 

Rich Site Feed 
The Rich Site Feed displays the continuous feed from the Telnet server. It also lets you 
interact with the server to set options like filters and to perform queries.  

 

DX Query Command Buttons appear on the right side of the DX Spot Checker window 
when Rich Site Feed is selected. There's one button for each command defined on the 
Additional Commands tab of DX Spot Checker Options. 

As shown earlier, right-clicking a button displays a shortcut menu, whereupon clicking 
Define brings you to the text box where you can define the command. 

Thereafter, depending on the definition of a command, left-clicking a button sends its 
command to the server immediately, or inserts a DX announcement template into the 
Send Command box for editing before sending the announcement to the server by 
pressing Enter on your keyboard.  

A List Commands box appears on the lower-right side of the window. It contains a list of 
pre-configured commands you can send to the cluster server immediately. By default, 



 

 54  

DXtreme Station Log 15 ships with list commands that query the cluster server for 
recent FT8 Fox/Hound activity. 

Simply click the desired list item: 

 

Then the arrow button: 

 

And the results appear on the Rich Site Feed display. 
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You can define, edit, and delete any list commands you want using the Define List 
Commands Module window, which is accessible by double-clicking List Commands — 
Double-Click Here to Define Commands: 

 

 

The numbers 10, 11, 12, and so on in the Order Description column sort the list in the 
desired order. Use numbers beginning with 10; avoid 0 through 9. 

 

  



 

 56  

Grid Feed 
The Grid Feed displays 10 to 50 rows (your choice) of DX spots in a structured, resizable, 
alternating-color grid. 

 

The DX Spot Checker is packed with features, but the overall intent is to let you see the 
stations you need to work for a new DXCC entity — overall or on each mode and band. 
Plus, it lets you see the stations you need to work for a new VUCC grid (if you have a 
subscription to QRZ XML Logbook Data, HamQTH.com, or Buckmaster HamCall). It 
performs these tasks by querying your Station Log 15 database to see what you need.  

Important: For best results, DXtreme Software recommends obtaining and activating 
QRZ XML Logbook Data or HamQTH.com while using the DX Spot Checker because 
those call sign subscription services return the DXCC Entity Code for each station most 
often, thereby increasing the accuracy of DXCC status indications. If the entity number is 
not returned, the DX Spot Checker uses the Entities, Prefix Cross-Reference, and Call 
Sign Cross-Reference tables to determine entity-needed status. The Source column on 
the Grid Feed displays CSS ### when the call sign subscription service returns the 
DXCC Entity Code, and Table when the aforementioned tables were used. DXtreme 
Software is not responsible for the accuracy of information a call sign subscription 
service provides. 
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Adding and Modifying Log Entries 
The focal point of DXtreme Station Log 15 is the six-tab Station Log window. You can 
use it to add new log entries and modify existing ones — plus a whole lot more. 

Adding Standard Log Entries 
You can add new log entries by clicking New and typing, clicking, and selecting 
information on the Station Log window. 

Logging Spotted Stations 
You can also add new log entries by clicking Log Spotted Station or Log Spotted 
Frequency and Station on the DX Spot Checker shortcut menu, which inserts initial 
contact data from the spotted station into the fields of the Station Log window, 
whereupon you complete the log entry by typing, clicking, and selecting additional 
information. 

Using JT Log Entry Processing 
If you’re a fan of WSJT-X, JTDX, or JS8Call, you can also add new log entries by clicking 
the JTP button and then the appropriate New Log Entry menu item, which inserts initial 
contact data from the application into the fields of the Station Log window, whereupon 
you complete the log entry by typing, clicking, and selecting additional information. 
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As part of completing log entries, you can accept or change the default information 
provided by your module definitions. And you can record stations; add records to an 
Outgoing QSL Web Service, Club Log, or eQSL.cc workfile; post to social media; create 
QSL and address labels; and associate Improv and QSL images. 

And you can have Station Log 15 upload log entries to LoTW automatically. 

 

Notes Regarding WSJT-X, JTDX, and JS8Call 
▪ Only the most recent WSJT-X, JTDX, and JS8Call contacts can be logged using JT 

Log Entry Processing. If desired, you can start a log entry, begin a contact with 
another station, and finish logging the previous contact before the new QSO 
ends. For rapid-fire and contest operations, you might want to log in WSJT-X, 
JTDX, or JS8Call and use Station Log's Import ADIF Utility to import log entries 
after you've finished. The Station Log 15 Help System explains how. 

▪ If you want to view or search an application's All.Txt or Log file, you can click the 
appropriate entry on the JT Processing menu. You might find these functions 
useful to search for decoded stations, entities, or grid squares without having to 
interrupt, or be interrupted by, new decodes on the application's window. 
JS8Call also has a Directed.Txt file you can view or search. 

Modifying Log Entries 
You can also modify log entries on the Station Log window, most often done when you 
receive a QSL card in the mail. Click the Verification tab to indicate the QSL card was 
received and, if you have an image scanner, scan a picture of the front and rear of the 
QSL for viewing later in QSL Imaging.  

You can also upload your log entries to Logbook of the World semiautomatically in 
batches and import LoTW QSL records to mark matched contacts as verified in your 
database. You can also capture images of your LoTW QSLs for later viewing. 

You can make other changes as well. It’s all up to you. 
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Last Log Entries Grid and Window 
Resizing the Station Log window turns on the Last Log Entries grid. And if you want to 
display more records at once, you can open a Last Log Entries window by means of a 
menu selection. The Last Log Entries grid and window show up to 5000 of the most 

recent log entries added. 

Double-clicking a row in the grid displays its log entry in the Station Log window. You 
can resize the grid columns and scroll horizontally to columns that do not appear 
initially, and right-clicking the grid brings up a shortcut menu that lets you sort records 
and access other functions. 
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A Properties dialog box can be invoked via the shortcut menu …  

 

… enabling you to: 

▪ Change the order of columns. (If you change the order, you may need to resize 
your grid columns.) 

▪ Set the maximum number of last log entries displayed (from 7 to 5000). 

▪ Add or remove a border. 

▪ Set font attributes for the grid's frame plus heading and data rows — one 

format for odd data rows, and another format for even data rows — 

throughout the program, not just for the Last Log Entries grid, but all 

grids in the system, plus the Quick Find box. 
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And even though you can scroll the Last Log Entries grid vertically and horizontally, 
sometimes you need more room to display all columns and their data. To say nothing of 
displaying additional rows. For time like those, you can open the resizable Last Log 

Entries window: 

 

The Last Log Entries window has all the functions of the Last Log Entries grid, but it can 
be set wider and longer. You can display the grid and window together, or separately. 
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Automatic LoTW Upload Caption and Bar 
You can place the progress caption and bar above the Last Log Entries grid if the grid is 
positioned at the bottom of the window. Doing so may be preferred if you choose not to 
display the Last Log Entries grid.  
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When you click Properties, the LoTW tab of the Preferences window appears so you can 
quickly change your active station location when necessary. 
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Outgoing QSL Web Service Integration 
DXtreme Station Log 15 has an Outgoing QSL Web Service facility that makes it easy to 
send official QSL cards via a third-party QSL bureau web site, such as QDure at: 

https://qsl.ure.es/en/ 

At the time of this writing, DXtreme Software recommends QDure. 

Note: As part of setting up an Outgoing QSL Web Service in Preferences, you type the 
name of the service you want to use, and that name appears in menus throughout 
Station Log 15 (hence the name QDure in our screen shots). 

How It Works 
You begin by adding, modifying, or displaying a log entry. Then, on the 
Verification/Outgoing tab, make sure the Outgoing QSL Sent box is set to Yes either 
manually or automatically as determined in Preferences. If necessary, click OK.  

Note: Because you will likely pay for the QSLs you send via an Outgoing QSL Web 
Service, and to avoid sending QSLs by mistake, Station Log 15 requires setting the Sent 
box to Yes before appending QSL records to the Service workfile. 

Next, on the Station Log toolbar, click the Process Outgoing QSL Web Service button. 
 

 

Or click the arrow next to the button and then Create/Upload {Name of Outgoing QSL 
Web Service} Records. 

 

  

https://qsl.ure.es/en/
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Station Log 15 creates the Outgoing QSL Web Service record and prompts you for the 
next action to perform. 

 

Click the appropriate button. 

In addition, when there's no log entry on display, you can click the Process Outgoing QSL 
Web Service button to upload pending workfile records to the server. 
 

 

Or click the arrow next to the button and then Create/Upload {Name of Outgoing QSL 
Web Service} Records.... 
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Station Log 15 prompts you for the next action to perform. 

 

Click the appropriate button. 

Whenever you upload records, Station Log 15 displays the Outgoing QSL Web Service 
site in your web browser where you must submit the upload file manually. (The 
Outgoing QSL Web Service site provides upload instructions.)  

Viewing the Workfile 
You can click the arrow next to the Process Outgoing QSL Web Service button and then 
View/Edit the {Name of Outgoing QSL Web Service} Workfile whenever you want to 
see or edit the records in the workfile. 
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Outgoing QSL Web Service Properties 
On the Outgoing QSLs tab of Preferences, the Outgoing QSL Web Service Properties 
area lets you specify the options you want. 

 

The Notes text box lets you type text that will appear on all bureau QSLs by means of 
the NOTES ADIF tag. 

The QSL Msg text box lets you type text that will appear on all bureau QSLs by means of 
the QSLMSG ADIF tag. 

Outgoing QSL Web Service functions are also accessible via the QSLing -> Create menu 
on the Station Log window. 

Outgoing QSL Web Service records are managed per database 

Club Log Integration 

Automatic Club Log Record Creation  

At your option, you can create Club Log records automatically when adding or modifying 
log entries. 

While you're adding or modifying a log entry, the Busy indicator appears on the Club Log 
toolbar button: 

  

When the record has been created in the Club Log workfile, the Done indicator appears 
on the button: 

 

Club Log records accumulate in a workfile per database until you upload them. 

Only qualified modifications are allowed to Club Log records, such as changes to the call 
sign, DXCC entity, date, time, band/frequency, mode, and QSL status (as in Yes or No). 

Note: You can also create Club Log workfile records manually by turning off automatic 
creation in Preferences. 
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Club Log Workfile Upload 
When you're ready to upload the workfile: 

1. With no log entry on display, on the Station Log toolbar, click the arrow next to the 
Club Log toolbar button and then Create/Upload Club Log Records. 

 

 

2. Click Yes to confirm, and Station Log 15 creates an upload file in the Exports folder, 
which by default is c:\DXtremeStationLog15\Exports 

3. When the Club Log Web site appears, upload the following file from the Exports 
folder: {Name of Database}_ClubLog_Upload.adi 

Refer to the Club Log Web site for upload instructions. 
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Batch Upload to Club Log 
Batch Upload to Club Log is useful when Club Log does not contain all your log entries. 
Thereafter, the automatic (or manual) method, described earlier, is recommended. 

When you're ready to perform a batch upload: 

1. With no log entry on display, on the Station Log toolbar, click the arrow next to the 
Club Log toolbar button and then Batch Upload to Club Log. 

 

2. When the Criteria window appears, specify a date, a range of dates, or other criteria 
to select log entries to upload. 

3. Click Run. Station Log 15 creates the Club Log records and writes them to a 
database- and batch-specific upload file in the Exports folder, which by default is: 
c:\DXtremeStationLog15\Exports 

4. When the Club Log Web site appears, upload the following file from the Exports 
folder: {Name of Database}_ClubLog_Batch_Upload.adi 

Refer to the Club Log Web site for upload instructions. 
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Setting Up Direct Print QSL Labels 
Before you use the Direct Print QSL Labels function to accumulate and print QSL labels 
on your printer, you must perform the following steps: 

1. On the QSLing menu of the Station Log window, point to Properties and click Direct 
Print QSL Labels. The Properties - Direct Print QSL Labels window appears. 

 
  



 

 71  

2. On the Properties - Direct Print QSL Labels window, enter the properties of the label 
stock you want to use if it isn’t listed, keeping in mind that you must adjust the Left 
Margin value to accommodate the additional left margin your printer imposes.  

Important Notes: 

▪ Usually, it is necessary to subtract an eighth to a quarter inch from the Left 
Margin measured on the label stock for Portrait-oriented stock, or from the Top 
Margin for Landscape-oriented stock. It all depends on the printer you are using. 

▪ And you may have to make this adjustment to the label stock properties that 
DXtreme Software provides as defaults. 

  

▪ Therefore, you must perform a test before you can print labels for mailing.  
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3. Use this procedure to create test labels that verify the properties of the label stock 
you want to use. Some experimentation may be necessary. 

a. With a QSO listed on the Station Log window that also has an address listed on 
the Station Information tab, on the QSLing menu of the Station Log window, 
point to Create and click Direct Print QSL Labels. 
 

 

b. Point to the space under the Label Name and Lines boxes and double-click to 
access the Direct Print QSL Labels Printer Options dialog box. When you first 
access this window, the area under the Label Name and Lines boxes may not 
have a visible hyperlink. Double-click anyway. (You must have already installed at 
least one printer on your system to proceed.) 
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c. Select the desired printer, paper size, and a non-proportional-space font, such as 
Courier New or OCR. Click OK.  

 

d. On the Create Direct Print QSL Labels window, select the desired stock in the 
Label Name box and enter 3 in the Lines box. 

e. Double-click a label number in the Available box, click the QSO Data option 
button, and then click the Commit button. 

f. Double-click a label number in the Available box, click the Address option 
button, and then click the Commit button. 

g. Click Close. 

h. Bring up another QSO on the Station Log window and access the Create Direct 
Print QSL Labels window again. Repeat Steps e and f. 

i. Click the Preview button to perform a print preview. Make sure that no 
information from one label encroaches upon another. If this happens, close 
preview and edit the appropriate label: Single-click the number of the offending 
label in the Reserved Labels list, right-click, and then click Edit Direct Print Label. 
Make the necessary changes. Preview again. 

j. Insert a regular piece of paper into your printer for the test.  

k. Click Now. 

l. Compare the printout to a blank piece of label stock. Make any necessary 
adjustments on the Properties - Direct Print QSL Labels window and perform the 
test again until you’re satisfied. 

  



 

 74  

Caution: Via the Edit menu, you can edit the raw data of Direct Print QSL labels in 
Notepad, enabling you to make changes to the QSO data. 

 

You must refer to the Procedural Help system for instructions before performing this 
task. 
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Reports 
DXtreme Station Log 15 has an array of reports that let you track the performance of 
your station. You run reports from the Reports menu of the Station Log window. The 
following types of reports are available. 

DXCC Analytics 
DXCC Analytics is a window-based tool that lets you analyze your DXCC data and quickly 
access the specific log entries upon which you need to take some kind of action, such as 
submitting or re-submitting a QSL or e-mailing the ham you contacted.  

You begin by selecting a desired mode, or all modes. DXCC Analytics then goes to work, 
building and displaying a record set showing the number of band entities Worked, 
Verified, and Worked But Not Verified (labeled Delta) for each band and for all bands. 
(As an option, check boxes let you specify whether to include Deleted and Non-DXCC 
entities in your analysis, and Power From and To boxes let you filter your analysis by the 
output power used; you can specify a single power level, or a range of power levels.) 

When you double-click a Worked, Verified, or Delta data element for a desired band, or 
for all bands, you see a list of entities that satisfy the element you chose, along with the 
number of QSOs in each entity. 
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When you double-click a desired entity, you see a list of its QSOs, including the band and 
date. You can sort this list by Station, Band, Date Ascending, or Date Descending. 

 

You can then load one or all QSOs into the Station Log window to perform a desired 
action on them ... while the DXCC Analytics window persists for further analysis. 

DXCC Analytics works with lots of data, and if your database has thousands of QSOs in 
it, you must allow it enough time to work. The results, however, are worth the wait. But 
when you want to work with an entity list over several days, you can use the Previous 
Entity List (PEL) feature described next. 
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DXCC Needed Lists  
After double-clicking a Worked or Verified data element for a desired band or for all 
bands in the Band Entities Summary area, and after the Entity List area displays its list 
of entities, you can click the Entity Needed List hyperlink to generate a list of entities 
you still need for the mode, data element, and band(s) clicked. 

 
If you want to retain your DXCC needed lists, on the File menu of Notepad, click Save As 
and save each list to the desired location using a unique file name. Alternatively, you can 
print each list. 

Previous Entity Lists  
When it builds an entity list, DXCC Analytics saves it to a local file, enabling you to 
reload its data later — in seconds! — to continue working with it. 

To reload a previous entity list, click the PEL button. The Select Previous Entity List 
window appears to let you select the entity list you want to reload. 

The data appears immediately. You can now continue to work with it. 
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WAS Analytics 
WAS Analytics is a window-based tool that lets you analyze your Worked All States 
(WAS) data and quickly access the specific log entries upon which you need to take 
some kind of action, such as submitting or re-submitting a QSL or e-mailing the ham you 
contacted. 

WAS Analytics works like DXCC Analytics. One difference is that the first time you use it, 
you must specify the DXCC entities that best represent the WAS entities for United 
States, Alaska, and Hawaii.  

 

You begin by selecting a desired mode, or all modes. WAS Analytics then goes to work, 
building and displaying a record set showing the number of band states Worked, 
Verified, and Worked But Not Verified (labeled Delta) for each band and for all bands. 
(As an option, Power From and To boxes let you filter your analysis by the output power 
you used; you can specify a single power level, or a range of power levels.) 
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WAS Needed Lists  
After double-clicking a Worked or Verified data element for a desired band or for all 
bands in the Band WAS Summary area, and after the WAS List area displays its list of 
states, you can click the WAS Needed List hyperlink to generate a list of states you still 
need for the mode, data element, and band(s) clicked. 

 
If you want to retain your WAS needed lists, on the File menu of Notepad, click Save As 
and save each list to the desired location using a unique file name. Alternatively, you can 
print each list. 

Previous State Lists  
When it builds a state list, WAS Analytics saves it to a local file, enabling you to reload 
its data later — in seconds! — to continue working with it. 

To reload a previous state list, click the PSL button. The Select Previous State List 
window appears to let you select the state list you want to reload. 

The data appears immediately. You can now continue to work with it. 
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Performance 
Performance reports let you track the overall performance of your station. The report 
shows the number of contacts per subject and whether the subject is worked or verified 
overall, and on each mode and band. You can produce a Performance report for each of 
the following subjects: 

▪ Entities 

▪ Continents 

▪ US-CA Counties 

▪ CQ Zones 

▪ Grid locators 

▪ IOTA numbers 

▪ Propagation Modes 

▪ States and Provinces 

▪ Digital Applications 

▪ User-defined fields (UDFs)  

Bands 
Bands reports let you analyze the performance of your station from a bands 
perspective. The report shows the number of contacts you have made per band — 
overall and on each mode. The report also shows grand totals for all bands and for each 
mode. 

Stations 
Stations reports let you see a list of the stations in your log. 
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Filtering Reports 
You can filter your Performance, Bands, and Stations reports by clicking the Criteria 
button on report dialog boxes. Several fields are available for filtering. 

 

You can therefore run reports that contain: 

▪ All the information in your log, or 

▪ Specific information from your log that satisfies the criteria you specify.  

For example, you can run a Performance report that shows DXCC entities that are: 

1) Verified 
2) By LoTW 
3) While operating FT8 
4) Using JTDX 
5) Running 1 to 50 watts 

Or perhaps you'd like to run a report for a specific antenna, to see how well it performs 
... or for a particular band, mode, or user-defined field … 

As you can see, there are many possibilities on the Set Criteria window. 
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Filtering Suggestion 
You should avoid running a Stations report without employing some kind of filtering if 
you have more than 50,000 QSOs in your database and you are outputting the report to 
the Active Report Viewer or the Standard Report Viewer. Web browsers have difficulty 
displaying such large reports. Expect a report of 50,000 QSOs to take upwards of ten 
minutes to appear. 

Output Devices 
You can output your reports to the following devices: 

▪ Printer — To the printer you select. Make sure you select a printer first. Follow 
the instructions in the on-line Help. 

▪ Viewer — To the DXtreme Active Report Viewer or Standard Report Viewer. 
See the next section for important information. 

▪ FTP — To the Web space provided by your ISP automatically, where you and 
your friends can access them remotely. When accessed from the Web, the 
reports appear within the Active Report Viewer or Standard Report Viewer. 

 

Running Reports When Using Station Log 15 on  
Windows 11 and Windows 10 21H2 and Later 
Microsoft® has disabled Internet Explorer® in Windows® 11 and Windows 10 21H2. The 
DXtreme Active Report Viewer relied upon Internet Explorer for its functioning, and 
DXtreme Software is pleased by the availability of Internet Explorer Mode in the 
Microsoft Edge™ browser. 

At the time of this writing, Windows 11 is in beta and Internet Explorer Mode is available 
from Microsoft. We at DXtreme have been testing the DXtreme Active Report Viewer 
within Internet Explorer Mode, where it is operating well. Further, we have noticed the 
continued evolution of Internet Explorer Mode, and we're confident the latest features 
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will make using the Active Report Viewer in Internet Explorer Mode a satisfying 
experience. 

Because the development of Internet Explorer Mode is ongoing, access the DXtreme 
Station Log and Internet Explorer Mode Information Center on the Web now and at 
regular intervals to prepare your PC to run reports. 

  

https://www.dxtreme.com/dxsl_iemode_ic/informationcenter.htm
https://www.dxtreme.com/dxsl_iemode_ic/informationcenter.htm
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Performing Updates 

Prefix and Call Sign Cross-References 
Performing Prefix and Call Sign Cross-Reference updates is essential for ensuring 
accurate entity selection in DXtreme Station Log 15. The program makes entity 
selections when you import ADIF files, add log entries, and use the DX Spot Checker. 

You should perform these updates at regular intervals. 

First, make sure the Entities module is up-to-date with the latest ARRL entities. 

Then, on the Modules menu, click Prefix Cross-Reference. On the Prefix Cross-
Reference Module window, double-click the Update hyperlink.  

 

The Prefix and Call Sign Cross-References Update dialog box appears. Double-click  
I Need the Country.Dat File. 
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Follow the instructions on the Prefix and Call Sign Cross-References Update window to 
download the Country.Dat file and start the update. 

 

After you click Update on the Prefix and Call Sign Cross-References Update dialog box, 
DXtreme Station Log 15 imports the latest prefix and call sign cross-reference data from 
the Country.Dat file. 

 

Click OK. 
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Performing an Interactive Update  
After installing a new or upgrade version of Station Log 15, you must perform an 
Interactive Update the first time you run a Prefix and Call Sign Cross-Reference Update. 
This action populates the exception cache with your selections. 

As it performs the interactive update, Station Log 15 links the special prefixes and call 
signs in the file with the ARRL standard prefixes in the Station Log 15 database. When 
Station Log 15 encounters a prefix or call sign in the file it cannot link, it prompts you to 
select the appropriate standard prefix on the Select Standard Prefix dialog box.  

 

This happens about 20 times while processing several hundred entries because the 
Country.Dat file contains some prefixes that are not standard ARRL prefixes. For 
example, you never see a prefix of 3D2/C in a call sign; you see 3D2.  

Most of the time, prefix differences are minor, and the proper prefix comes up after you 
type one or two characters.  

Sometimes, it is useful to type a prefix and then use the arrow keys on your keyboard to 
scroll to the proper entity. 

After you perform the update a few times, you tend to memorize the corrections. It 
takes about 10 minutes to perform an interactive update. 
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To assist you in performing your interactive updates, the following table shows the not-
so-obvious prefix associations you might encounter: 

Country.Dat Prefix Select This Prefix 

3DA 3D6 

4U1V OE 

CE9 KC4 

CM CO 

FT5X FT8X 

FT5Z FT8Z 

GM/S GM 

HM P5 

IG9 I 

IT9 I 

JW/B JW 

PJ7 PJ5 

UK UJ 

VR VS6 

YA T6 

Performing Non-Interactive Updates  

After performing an Interactive Update, you can then perform Non-Interactive 

Updates instead. The Prefix and Call Sign Cross-Reference Update facility will 

use the exception cache to automatically enter the selections you made previously. 

The only dialog box you'll see during a Non-Interactive update should be this one, 

announcing the update complete: 
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Clearing the Exception Cache  
At times, you'll need to clear the exception cache. For example, after making prefix-
related changes to the Entities module, adding one or more new entities, or stopping an 
update in process.  

To do so, double-click Clear Exception Cache on the initial dialog box.  

You will then need to perform an Interactive Update again to build a new exception 
cache.  

Notes:  

▪ DXtreme Software is not responsible for the content or future availability of the 
Country.Dat file. This file is provided by AD1C solely for the enjoyment of 
Amateur Radio operators. (The Country.Dat file and AD1C web site are 
copyright-protected by James J. Reisert, AD1C.) 

▪ Prefix and Call Sign Cross-Reference updates are database specific. 
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Logbook of the World Users 
Performing Logbook of the World Users updates is essential for ensuring that LoTW user 
indications displayed in DXtreme Station Log 15 are accurate. The program displays 
LoTW user indications — including the date and time each LoTW user last uploaded log 
entries to his or her account — when you import ADIF files, add log entries, and use the 
DX Spot Checker in Grid Feed mode. 

You should perform these updates at regular intervals.  

The upload file is available directly from the ARRL and is quite large.  

As such, allow 8 to 30 minutes for the LoTW Update process to conclude, depending on 
the speed of your computer. In our lab, an Intel Pentium 4 PC running Windows XP took 
30 minutes to update, while an Intel Core 2 Duo E6750 PC running Windows 10 took 17 
minutes. An Intel Quad Core i5 PC running Windows 10 took only 8 minutes. 

On the Modules menu, click LoTW Users Update. The Logbook of the World Users 
Update dialog box appears. Double-click I Need the LoTW File. 

 

  



 

 90  

Follow the instructions on the Logbook of the World Users Update window to 
download the Lotw.Txt file. 
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After you click Update on the Logbook of the World Users Update dialog box, DXtreme 
Station Log 15 imports the latest LoTW users from the lotw-user-activity.csv file. 

Important: If the call sign display in the title bar freezes, or you see Not Responding 
messages, ignore them. Depending on the speed of your computer, wait at least twice 
the time we indicated earlier. Eventually, you’ll see this message box: 

 

And enjoy seeing LoTW user indications in Station Log 15. 

 

Notes:  

▪ DXtreme Software is not responsible for the content or future availability of the 
lotw-user-activity.csv file. 

▪ Logbook of the World Users updates are database-specific. 
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IOTA Reference Numbers and Descriptions 
Performing IOTA™ updates is essential for ensuring that IOTA selections and reports in 
DXtreme Station Log 15 are accurate. 

Important: You must perform an IOTA™ update before you can use IOTA numbers in 
DXtreme Station Log 15. However, DXtreme Software does not have permission to 
distribute the Islands On The Air directory. We can allow you to add, modify, and delete 
IOTA reference numbers and descriptions on the IOTA Module window. 

While DXtreme Software does not have permission to distribute the Islands On The Air 
directory, DXtreme Station Log 15 can import the directory after you:  

a. Obtain it for non-commercial use from whatever source you can find.  

b. Create and format it as a space delimited text file. 

For each record, the 6-character IOTA Reference Number must appear on the 
left, followed by a space character, and then by the description, which typically 
consists of the island name and a standard prefix. Example: 

IOTA-Number Description 

c. Press Enter after each island record. There can be only one island record per line. 

d. Save the file as iotashortlist.csv in your current database folder, such as 
c:\DXtremeStationLog15\Database.  

To perform the import, on the Modules menu, click IOTA. On the IOTA Module window, 
double-click the Update hyperlink.  
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The IOTA Module Update dialog box appears. Double-click Start Here to begin. 

 

Follow the instructions on the IOTA Module Update window that appears. (We are not 
showing it here because it might change during the life of this document. Check the 
Information Center for possible updates.) 

Notes:  

▪ DXtreme Software is not responsible for the content or availability of the IOTA 
data you may find. 

▪ IOTA updates are database-specific. 
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NOAA Solar Indices 

Today's Solar Indices 
Today's solar indices appear when the DXtreme Station Log 15 is started and are 
updated automatically every thirty-minutes thereafter (if your Internet connection is 
active and the information is available from NOAA). Today’s solar indices can also be 
updated on-demand (if available) by clicking the solar indices display on the menu bar. 

 

An Internet connection is required, the information must be available from NOAA, and 
acquisition must be enabled on the Solar tab of Preferences (described earlier). Solar 

indices also appear in the menu bar of the DX Spot Checker and can be applied to 

log entries being imported by the ADIF Import Utility.  

When you click the New button or the JTP button to log a contact, the editable Solar 
Indices text boxes — entitled SFI, Ap, and Kp — display the solar information that is 
valid currently — provided your Internet connection is active, the acquisition of solar 
indices is enabled in Preferences, and solar information is available from NOAA. 

 

The current solar indices are also displayed when you double-click the SFI, Ap, and Kp 
text boxes and when you tab out of the Call Sign, Date, Start, and Freq boxes. If server 
access to NOAA is slow, you might need to perform one of those tasks to display the 
indices. When you click OK, the software saves the displayed solar indices with the log 
entry. 

If all else fails, you can type the solar indices manually for saving to the log entry. If you 
need to find solar information that is older than right now, you can click the Historic 
button to access a web page of relevant information (one is specified in Preferences by 
default).  

When an existing log entry is on display, you can also modify the solar indices manually. 

If you need to type solar indices often, in Preferences you can turn on Tab access to the 
SFI, Ap, and Kp text boxes as well as the Historic button. 

As before, you can run Performance, Stations, and Bands reports against the solar data. 
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Historic Solar Indices Update Facility 
The Historic Solar Indices Update facility lets you update a batch of log entries with 
solar data valid at the time of the QSO, provided the QSO took place on or after  
January 1, 1997 and the information is available from NOAA. 

Running an update is useful after performing an ADIF Import. It is also useful when solar 
values were not available from NOAA at the time you logged your QSOs. If, for example, 
the NOAA server was down, or your Internet connection was out.  

Note: Before you can use the Historic Solar Indices Update facility for the very first 
time, you must (one-time) configure access to NOAA's FTP server in the Properties for 
Retrieving Historic Solar Indices from NOAA area. Refer to the on-line Help for 
instructions. 

Then to update: 

1. Start the Historic Solar Indices Update facility from the Edit menu of the Station Log 
window and click Get to download historic indices from NOAA using the FTP Client 
specified. The Get function works the same as it does on the Preferences window. 
Refer to the on-line Help for instructions. 

2. After the Get operation is completed, if desired specify the desired date range filter 
in the Filter Options area. If you want to update your entire log, enter no dates. 

 



 

 96  

3. Click Run and wait until Station Log 15 informs you the update is complete. You 
cannot stop an update in process. 

 

4. Click OK and the date and time of the update appears on the Historic Solar Indices 
Update window. 
 
Notes:  

▪ DXtreme Software is not responsible for the future availability or accuracy of 
solar information from NOAA. 

▪ Solar updates are database-specific. 
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Support 
Our support is second to none.  

You get support by Internet e-mail.  

So, if you need help, drop us a line and we’ll do our best to assist you. 

Write to us at: support@dxtreme.com. 

mailto:support@dxtreme.com
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